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WHERE IN THE USA IS CARMEN
SANDIEGO?®

The whole USA is your beat! Carmen
and her gang are stealing America's
national treasures, and you're on their
trail. Includes Fodor's® USA Travel Guide
to help you decipher clues.

WHERE IN EUROPE IS CARMEN
SANDIEGO?®

Carmen strikes again! This time you'll
pursue Carmen through the 34 nations
of Europe. For vital information, you'll
have an on-screen data-base and the
RandMcNall~Concise Atlas ofEurope.

Carmen Sandiego products are available for the IBM®
PClTandy®, Apple® II, AP~le® IIGS, Macintosh®,
Amiga® and Commodore A 64/128. (All titles may not
be available for all computers.)

WHERE ON EARili WIll
CARMEN SHOW UP NEXT?

WHERE IN TIME IS CARMEN
SANDIEGOr~

Chase Carmen through the ages!
Investigate 1500 years of historical
events, famous people and important
inventions. Includes the New American
LibrarjID Desk Encyclopedia.

Visit your local software dealer or call (800) 521-6263, 8am-5pm PT
for credit card purchases and ordering by mail.

Congratulations on joining the
Acme Detective Agency!

You're about to discover how
much fun it is to track down Carmen
Sandiego and her gang of master
thieves!

And when you've mastered "Where
in the World ..." there's still more
adventure waiting for you: Three other
great Carmen Sandiego games are
available.

For more information. write to Br0derbund Software-Direct, P.O. Box 6125, Novato, CA 94948-6125. © Copyright 1990 Br0derbund
Software, Inc., 500 Redwood Blvd., Novato, CA 94948-6121. All rights reserved. The New American Desk Encyclopedia, Fodor's and
Rand McNally are registered trademarks of New American Library, Fodor's Travel Publicat:"ns, and Rand McNally and Company,
respectively. IBM, Tandy, Apple, Macintosh, Amiga and Commodore are registered trademarks of International Business Machines
Corp., Tandy Corp., Apple Computer, Inc. and Commodore-Amiga, Inc., respectively.
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WHERE IN THE WORLD IS CARMEN SANDIEGO?®
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Apple IIGs·
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A Mystery Exploration Game
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THE CHASE IS ON ...

Monday, 5 a.m. A ringing sound jars you awake. You grope
for the phone and drop the receiver on the floor. Out of the
darkness comes the voice of the chief: "Wake up, kid. Got an
assignment for you."

You stumble out of bed, turn on the light and grab your brand
new detective's notebook.

"Just got a call from Interpol," says the chief. "Looks like
Carmen's gang has pulled another caper."

"Any leads?" you ask.

"Not with this bunch. They're too slick. Can't give you any more
details on the phone. Better get down to the office double
quick. It's going to be a rough one."

"Right, chief:'

As your trembling hand replaces the phone on its cradle, you
wonder why you ever got into this line of work. Before this
morning, Carmen Sandiego and her Villains' International
League of Evil (or V.I.L.E.) were just sensational headlines in
the newspaper. For more than five years, Carmen and her gang
of felons had managed to stockpile the world's most valuable
treasures, while outwitting every so-called "crime expert" from
New York to Sydney. Now they've struck again. And you, the
newest employee of the Acme Detective Agency, have been
given the near-impossible assignment of tracking them down.

Good luck!

(
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GETTING STARTED

Loading the Program
Macintosh:
Turn on your computer. Insert the WHERE IN THE WORLD IS CARMEN
SANDIEGO? program disk into your disk drive. Double-click on the icon
titled Carmen World when it appears on the desktop. The program will
load itself into your computer and an animated title sequence will appear.
Click the mouse button to stop the animation and begin the game.

ApplellGS:
For two disk drives:
Insert both disks of WHERE IN THE WORLD IS CARMEN SANDIEGO? into
their respective disk drives. Turn on your computer. Double-click on the
Carmen World icon when it appears on the screen. The program will load
itself into your computer and an animated title sequence will appear.

E eITi3button to stop the animation and begin the game.
or one disk drlv

In dJ~.l$.kJ ERE IN THE WORLD IS CARMEN SANDIEGO? into your
disk drive. Turn on your computer. When the disk icon appears on the
desktop, eject Disk 1 by pressing the button on the disk drive. Insert Disk 2.
Double-click the Carmen World icon when it appears on the screen. At this
time you will be prompted to swap disks; follow the instructions on the
screen. After the program has loaded itself into the computer, an animated
title sequence will appear. Click the mouse button to stop the animation
and begin the game.
Note: The program requires ROM version 1.0 or higher.

Amigo:
Turn on your computer. Insert the WHERE IN THE WORLD IS CARMEN
SANDIEGO? program disk into the disk drive. (Amiga 1000 users will have
to insert the Klckstart'M disk first.) Double-click on the disk icon, then on
the Carmen World icon when it appears on the Workbench.'M The pro
gram will load itself into your computer and an animated title sequence will
appear. Click the left mouse button to stop the animation and begin
the game.

Installing the Program on a Hard Disk:
Apple IIGs:
Copy all files (excluding the system folder) from the Carmen Program
Disk(s) to a folder on the hard disk. For more information regarding copy
procedures please refer to your computer manual.

Apple IIGS Note: The 512K Apple IIGS computer with a hard disk drive
requires "Carmen World" to run with a 3.2 system disk (system disk
is included with the program).

If you are using System 4.0 or later on your Apple IIGS system, you will need
to have more than 512K RAM installed.

If you are using System 5.0 or later on your Apple IIGS system, copy Tool 032
from your Apple System.Tools disk into the Tools folder in the System folder
on your startup disk before running Carmen.
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Amigo:
Turn on your computer ond hard disk. Double-click the icon for
your hard disk to open the hard disk window. Create a new
drawer by single-clicking the Empty drawer icon on your hard
disk and then choosing Duplicate from the Workbench menu.
Rename the new drawer, which will now be named Copy of
Empty. by single-clicking it and selecting Rename from the
Workbench menu. Rename the drawer Carmen World. Insert
the Carmen World disk into your floppy disk drive.
Double-click the Carmen World icon. Drag the drawer icon
named Carmen World Data and the program icon named
Carmen World from the floppy disk to the new drawer on your
hard drive. Double-click the Font Mover icon. Click the gadget
that represents the destination to where the Font Mover
should copy all of the fonts on the Carmen World program
disk. You should select the font directory on your hard drive or
the font directory on the Workbench floppy disk that you
usually start up your Amiga with.

Hold down the left mouse button and drag the cursor over the
fonts that you want to copy to the destination directory. You
should select all of the fonts on the Carmen World program
disk. The fonts highlighted will be copied to the destination
directory.

Click the Copy gadget to initiate the copy procedure. After the
Font Mover has finished the copy, click the Close gadget in the
upper left hand corner of the Font Mover window.

USING EXPANDED MEMORY

Amigo:
If you have one megabyte or more of memory you can run
WHERE IN THE WORLD IS CARMEN SANDIEGO? faster by telling
the program to use more memory. The program will use about
512K of additional memory. To run the program using additional
memory you will need to change the N to a Y in the tool types
of the Carmen World program icon.

Single-click the Carmen World program icon. The icon should
now be highlighted.

Go to the menu bar and place the pointer over the word
Workbench. Press the right mouse button and select Info from
the pull down menu.

The info window will appear with Carmen World in the Name
box. Toward the bottom of the Info window, a box will say:

TOOL TYPES BIGMEM = N 11/I
Change the N to a Y for Yes. •

Click the Save gadget at the bottom of the Info
window. The change will be saved, and the
Info window will close. ••
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The program will now run with additional data in memory.
Should there be too little memory for the program to run with
BIGMEM=Y, an alert will appear when you try to run the
program. If you see the message, "Not enough memory! " go
back into the Info window and set BIGMEM=N.

ONE LAST NOTE!

Carmen World is designed to run from your Workbench.
There are two keyboard commands that you might find
valuable. The "A" shown below refers to to the Amiga key to
the left of the space bar. By holding down the Amiga key and
pressing the "n" or "m" you will achieve the following results:

A+n: bring the Workbench forward
A + m: send the Workbench to the back

Using the Program
Macintosh and Apple IIGs:
Except for entering your name into the Acme Crime Computer
your keyboard need not be used at all when playing WHERE IN
TH.E WORLD IS CARMEN SANDIEGO? However, if you enjoy
uSing the keyboard, you may press the Return key instead of
clicking the mouse whenever you see the prompt, "Please click
here to continue." In addition, you may type in Y for Yes and N
for No instead of clicking the mouse on the appropriate button.
You may also simply press the Return key to signify a "Yes"
response.

Amigo:
Whenever you see the prompt, "Please click here to continue,"
you must click the left mouse button or hif Return. The menu
bar is hidden while playing the game. In order to see the menu r
options and make a selection, click the right mouse button.

_TO_C_A_JC_H_A.::......T.:....:..H..:....:..I=EF ........:.(~r---:~--. _-"---==-=:.--_
Signing-in

The investigation begins at the Acme Detective Agency, your
home base. Type your name into the Crime Computer and then
press Return. Once you've signed in, the Acme Crime
Computer will display your current rank as a detective and give

Maclntolh
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you the details of your assignment. These include what
treasure has been stolen, where it was stolen from, whether
the thief is a male or female, and your deadline for arresting
the criminal. When you're ready to continue, simply click the
mouse or press Return and you're on your way.

Resuming a Saved Game

Before being promoted to each new level, you must pass
a Qualification Quiz using THE WORLD ALMANAC
included in the package. You will have three chances to
answer correctly. If you pass, you will be immediately
promoted. If you fail, you will need to solve another case
before you can retake the quiz.

AppI.UGS

TOOLS OF THE TRADE

41•

Clicking this icon will show a list of all the possible
destinations reached by connecting flights from your
present location.

It's a good idea to do this first to see where the thief
might have gone. Clicking the mouse on the icon a
second time will hide the list from the screen.

BEGINNING THE SEARCH

I
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The icons in the lower right of the main screens provide the
means to locate and arrest your suspect.

The menus across the top of the screen provide useful informa
tion about both gang members and crimefighters.

The Icons

Your starting point is the scene of the crime-the city where
the thief swiped the treasure. You should refer to your Official
Interpol Map (in this manual, pages 12 and 13) to orient your
self geographically after arriving at this city or any of your
subsequent destinations.

The main screen always gives your present location and tells
you what time it is and what day of the week it is. As you arrive
in each new city, be sure to read the descriptions that appear
on the screen. The descriptions contain information that will be
useful in pursuing Carmen and her gang. The pictures
themselves-notable landmarks or typical scenes from that
country-may also come in handy.

r5l
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The thief is hiding out in one of 30 cities. Your job is to track him
or her down, using clues you unearth along the way. Clues can
lead to the city itself or the country in which the city is located.

Clues to the identity of the thief will be given to you as you
pursue the villain from city to city. You'll log these clues into the
Crime Computer. When the identity of the suspect has been
established the Computer will issue an arrest warrant.
Obtaining ~ warrant Is very Important. If you don't have
one, you won't be able to arrest the thief once you catch
up with him or her.
There are 10 possible suspects, anyone of whom could be the
thief. Carmen Sandiego is the most elusive of the lot. During
your search, the Pollee Dossiers menu allows you. to s~lect the
individual crime file for any of the suspects. The crime files are
also available at the end of this manual in a slightly different
form.

As a new detective, you begin at the Rookie level. As your
investigative skills improve, you climb your way up t~rough the
ranks-five levels in all-until you reach Ace Detective. The
higher your rank, the tougher the case you'll be assigned.

The Crime Computer, THE WORLD ALMANAC® AND BOOK OF
FACTS and the Police Dossiers will all be useful in unraveling
clues.

Work quickly. You have only a limited amount of time to solve
the case. The Crime Computer will let you know what your
deadline is.

YOUR ASSIGNMENT
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If a game has been previously saved under the name you type
into the Crime Computer, you will be asked if you want to
resume that game. If you do, the Crime Computer will refresh
your memory on the state of the game as you left it. If yo~ don't
resume the saved game, it will be lost when a new game IS

begun under the same name. For information on how to save a
game see the File menu, page 10 under "The Menus". To speed
the scrolling text, simply press the ll€ key.

Note: To speed the scrolling text, simply press
the F1 key.



Note: If you double-click on one of the listed destina
tions you will immediately travel to that location. This
provides a shortcut alternative to clicking on the
Depart icon described below.

I A~ Clicking this icon lets you unearth clues within
& each city so you can track the suspect to the next
~ destination. A window will be displayed containing

three specific locations for you to investigate. Simply click
the one you desire.

Visit as many or as few locations as you wish, but remember
that the more investigating you do, the more valuable time you
lose. Use THE WORLD ALMANAC to help unravel the clues
you dig up.

I.,.,,,,,.'IWhen you think you've gathered enough clues to!!' id~ntify the crimin~l, c1ic~ this icon and th~ Interpol
-'-" Crime Computer will be displayed. The Crime Computer

lists various identifying characteristics on its screen. Click each
characteristic repeatedly to cycle through the available
choices.

When the characteristics you want are displayed, click on
Compute and the Crime Computer will search through all
known facts about each possible suspect. A warrant will be
issued if the characteristics you entered into the Crime Com
puter fit the profile of only one suspect. If the characteristics fit
more than one suspect, the names of all possible suspects will
be displayed. In this case you'll have to gather more clues
before a warrant will be issued. To return to the search, click
any icon below the Crime Computer.

The Menus

The Police Dossiers menu contains a crime file on each of the
members of the Carmen Sandiego gang. Each file contains the
identifying characteristics of a particular criminal.

, ......: .....,.,.4DPHI'"$lnllUbh cwitflouthern.lby
t1KklK.
...... 6,..t fondness for teeos.

11
_·,--....,...
~F_IO!'

." .U..t~fOf"mf'f"~IOI'I....
IntO!'IlI~O!'Sf'rVlc.QfMoneo:o

• -.....:hnftl1
...£e6er.Peikt'sh-bI'"o....n

". ..t« 1939 p~(lllt"(1 COf1Vfftibl.

(armen \andiego ...
Merey LaRuL..
Dazzle Annie Nonker...
lady flgalha Wayland, ..
len MRed" 8ulle..
Scar Graynolt ...
Nick Brunch...
Fut Eddie B .
thor Ihorouitch...
Katherine "Boom-Boom" Drib...

Lamp 'ili1m".iYP*[. flit>

r"'F.T' Clicking on this icon lets you depart for the city of your
-.-h- choice once you're ready to take off after the suspect. A

map will be displayed on the screen with a blinking dot
at your current location. Simply click on the city to which you
want to travel.

• ppl.lloi
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SLEUTHFUL HINTS

4. By looking under "Finance: Currency" in the section describ
ing each country, you'll discover that the kroner is used in Nor
way, the dollar in Canada, and the pound in the United
Kingdom. Looks like Norway is where you should head!

Where does the king cobra live?
1. Again, first check your connections, then use your OFFICIAL
INTERPOL MAP to identify the countries where these cities are
located.

2. Think of the general category in THE WORLD ALMANAC
where you might find information about king cobras - in this
case, snakes.

3. Look up "Snakes" in the index, and turn to the appropriate
page.

4. Find "King Cobra" under "Snakes." From the description, you
now know that its home is South Asia. If one of the connecting
cities were Bangkok, the capital of the Southeast Asian notion
of Thailand, this city would be a good place to go!

The thief cleverly stays in hiding, and orders a crony to check
you out. When you see a suspicious person run across the
screen, you know you're on the right track.

No thief worth his or her salt gives up without a fight. The
closer you get, the more dangerous your situation becomes.

Use the Crime Computer sparingly or you'll use up valuable
hours. And don't waste time playing tourist or aimlessly criss
crossing the globe. Instead, use THE WORLD ALMANAC to
d.ecipher clues and keep your investigation time down.

Be sure you've been issued on arrest warrant by the Crime ~.

Computer before you catch up with the thief. If you don't have a
warrant, issued for the correct suspect, you can't make on
arrest and the thief will slip through your fingers.

Every case is different. Whenever you begin a new assignment,
you start at a new city. You'll be looking for a new stolen trea
sure, and a new suspect.

If you've reached the top of the detective ronks and have been
retired, you can get bock on the job by picking an assumed
nome. Your real nome could be on a hit list!

I..

•
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Your most important investigative tool is THE WORLD
ALMANAC. Here you'll find information about nations of the
world plus other facts you'll need to catch your suspect. Start at
the index, located in the front (not the back) of the book to find
the country or other subject in question. Remember: Clues may
point to either the connecting cities or other locations within
those countries.

Examples for Using THE WORLD ALMANAC

What country uses kroner as its currency?
1. Check your connections to find out which cities the thief
might have fled to. The possible connections could be Mon·
treal, London, and Oslo.

2. Check your OFFICIAL INTERPOL MAP to identify the countries
where each city is located. You'll find Montreal in Canada,
London in the United Kingdom and Oslo in Norway.

3. Locate these countries in the index and turn to the appropri
ate pages.

USING THE WORLD ALMANAC

The Edit menu is not used at all in the Macintosh and Apple IIGS
versions of WHERE IN THE WORLD IS CARMEN SANDIEGO.
It is provided only so that you can use it with Desk Accessories.

The File menu allows you to begin a new game by selecting
New Game. Your old game will be lost when you do this. Se
lecting Quit from the File menu lets you leave the program.
After selecting Quit the current game, if a game is in progress,
will automatically be saved.

The Game menu contains the Hall of Fame which lists all the
crimefighters that have managed to capture Carmen Sandiego
herself. The menu also contains the Acme Detective Roster
which provides a list of all crimefighters and their current rank.
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